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3-Dimensional analyses* of deep-water deposits in Los Molles
Formation, La Jardinera area, Neuquen Basin

*Calculating thickness trends for stratigraphic units using remote sensing data

1. Introduction

The Los Molles formation, part of the Cuyo Group, is a sedimentary succession deposited
during the Early Jurassic during a period of increased subsidence, outcropping in the Southern
Neuquen basin, in the La Jardinera area (fig.1). It presents great outcrop exposure for deep water
lithologies, offering a clear perspective of an oblique down-dip profile and along strike profile
according to the progradation of the deep water depositional system towards the NE.Being
affected by a typical arid climate as part of Northern Patagonia and located close to the foothills
of the Andes, the area is not covered by proeminent vegetation, with the sandstone cropping out
on steeper slope profiles with the finer deposits (mudstones) dominating the low gradient slopes,
overlain by a thin interval of soil. The goal is to use slope gradients, xyz data and field data
(strike-dip measurements, GPS measurements) in order to isolate the most continuous sandstone
intervals over the entire area, creating structural and thickness maps for different stratigraphic
intervals.
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Fig. 1 Location Map of Study Area (Franzese 2006)
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1. Dataset

A digital elevation model (DEM, Res: 30 m) is an essential part of spatially analyzing the
elevation data, associated with a satellite high resolution image offers a good perspective for
lithology distribution in the area. Field data (GPS data acquired using a hand held Garmin GPS
device, strike-dips measurements using a Brunton geologic compass) will be associated with the
DEM and the satellite image(fig. 2) in order to better illustrate spatial correlation.

The DEM data (fig. 3) is available through the Advanced Spaceborne Thermal Emission and
Reflection Radiometer (ASTER). The ASTER data (0.00027777778, 0.00027777778) was
downloaded online (http://asterweb.jpl.nasa.gov/gdem.asp) and georeferenced over the study
area (La Jardinera area, using WGS 1984, UTM zone 19 S as a projection datum). Additional
data was added from the field (GPS data points) acquired by “walking out the units” in order to
determine regional correlation for stratigraphic units.

All the data must be converted to the UTM coordinate with the following properties:
Spatial Reference: WGS 84 UTM_zone_19S
Linear Unit: Meter (1.0000000)
Angular Unit: Degree (0.017453292519943299)
False easting: 500000
False northing: 10000000
Central meridian: -69
Scale factor: 0.9996
Latitude of origin: 0
Datum: D_WGS 1984


http://asterweb.jpl.nasa.gov/gdem.asp

Eugen Tudor, 2013

o 05 1 2 3
s i l0meters

352000 354000 356000

34g000 350000

A6 45000
[
5645000
}z

5642000
5639000

5639000

5636000

=
=
=
o
o
-
%]

5633000 0
5633000

350000 352000

Fig. 2 High resolution satellite image showing outcrop exposure in the La Jardinera area with
contours (100 m spacing)
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Fig. 3 Snapshot of DEM in the study area showing no discernable structure in the area
2. Workflow

In order to identify stratigraphic intervals we will use a combination of field data and satellite
imagery. We are interested in obtaining a good regional stratigraphic correlation and to observe,
if possible, thickness variations along the stratigraphic intervals. The area presents structural
complexity with an anticline and a syncline deforming the strata (fig. 4). Using strike and dip
measurements from the field we know that the variability of the dipping strata is extensive, with
bigger dip values close to the axis of the structural features and smaller dip values as we move
away from the axes. Besides the structural complexity that resulted from the thrusting, the
volcanic intrusions also complicate things. We observe topographic highs where magmatic
intrusions have intruded the surface. The stratigraphy doesn’t seem to be displaced, but the
topographic variability complicates things, thus we need to take into account the slope gradient
for thickness calculations.

In order to calculate the true thickness for a given stratigraphic interval we will need
digitized polylines, from which we will extract z values from the DEM and together with the
slope and dip values of a given unit we can apply the mathematical formula
(Thickness=Width*sin(Dip-Slope)).
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Fig.4 Geologic map of the study area and cross-section showing the structural complexity
(Garcia Morabito and Ramos 2012)

3. Data Processing

3.1 The Color map for the satellite image (fig. 5) has been changed in order to better
illustrate the outcrop belt.

3.2 Create contours using 3D Analyst Toolbox - > Raster Surface -> Contour. Define contour
spacing as you wish.

3.3 Trace top and base of the stratigraphic unit using satellite image (fig. 4) and GPS data
from the field, with the 3D Analyst tool -> Interpolate Line -> Profile Graph. Export data
to .xls format and import the data in ArcMap as X, y data (File-> Add Data -> Add XY
Data).

3.4 Open Attribute Table. You should have X, Y, Z data from the topographic profile for
each profile (top and base of strata)
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Fig. 5 Satellite image showing outcrop traces in the area
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3.5 Create a table that contains these fields (at the very least:

a) Unique ID: This might be a concatenated field based on the IDs of your two points. If
your table contains the IDs of both points as well as a concatenated ID field, you can
join the data together at the end.

b) X coordinate of the first point

c) Y coordinate of the first point

d) X coordinate of the second point

e) Y coordinate of the second point

f) Note: X and Y coordinate fields can be created by calculating geometry in a point
layer’s attribute table

3.6 Open the XY to Line tool (Data Management Tools > Features > XY to Line).

1.
2.
3.

a) Make sure the ID field is specified.

b) GEODESIC should be the line type so that a straight line is created

Open the attribute table of the resulting layer.

Add a field (type: Double) named Distance

Right click on the heading of Distance, click Calculate Geometry, and calculate the
length in whatever units you wish.

(Workflow can be found here:
http://kb.mit.edu/confluence/pages/viewpage.action?pageld=11338190)

Next steps:

At this point you should have two layers with points evenly spaced and a layer (polylines)
with the distance between the two layers (a swath of lines connecting opposite matching points).

1.

In order to calculate the thickness (fig. 6) we will need to assess in which direction are
the beds dipping:

In our case the beds are dipping in the same direction of the slope at an angle greater than
the slope with an apparent thickness measured parallel to dip direction. This case can
change often throughout the study area. The formula must be modified accordingly.

Case5and 6

Fig. 6 Case for Dipping beds and Slope

T =h(sin 6) - v(cos 0)


http://kb.mit.edu/confluence/pages/viewpage.action?pageId=11338190
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-where h represents the horizontal (map) apparent thickness in dip direction
-where v represents the elevation difference between top and bottom of bed
-where 6 represents the true dip of bed
-where T represents true thickness

The angles 6 should be converted from Degrees into Radians for the Field Calculator

using: Radians= (Degrees*m)/180

From the two layers we found the Distances between points (that will be the width of the
outcrop (W). Now we need to find the height (H) between the two layers.

a) Open Attribute Table of the layer you just created. You will need the elevation values
from the input data. Join the data from the tables using the “Join” function. Turn all fields
off that don’t contain X, Y data from the two layers, Distances and the two fields with
elevation. “Add field” (type: Long Integer) and name it Differences. Open Field
Calculator for the layer and calculate (Elevation 1 — Elevation 2).

“Add field” — we will need to calculate the DIP for the strata using the “three point
problem” method. Add Dip values to the field after calculating using point values chosen
by the user according with the geology (outcrop belt can change strike orientation). In
this case from field measurements it looks that the strike remains constant and the dip has

b)

a similar value along the outcrop belt.
c) “Add field” — we will need to convert the Dip into Radians (Radians= (Degrees*m)/180)
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Fig. 7 “Three Point Problem” graphical method illustration
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Results

The aim of this project is to produce thickness maps using remote sensing data with field
data, if possible.

In order to create maps we have the possibility of using several spatial interpolation techniques
in ArcMap. For this project we used Natural Neighbor (ArcToolbox/Spatial Analyst
Tools/Interpolation/Natural Neighbor), this method is ideal as it won’t produce peaks or pits
outside of the data. Other methods such as Trend, inverse distance weighting or krigging were
tried but the results weren’t useful.

The map was created using calculated thicknesses and XY data (top of unit) from the
Attribute table of the outcrop belt.

A structural map was created using the same technique in order to illustrate the elevation
variation along the outcrop belt. The data shows dip towards the West (valley) and N-NE
(general trend) with a small slope towards the East (valley). The following figure illustrates the
general trend along a cross-section parallel with the dip.

Valley and Ridge Topography in Tilted Strata

scarp slope dip slope

Observations

This method can be applied using only Digital Elevation Models and satellite imagery.
The dip and strike if not measured from the field can be calculated directly in ArcGis, this is
highly recommended especially if the outcrop belt is changing orientation along a profile. The
slope orientation in relationship with dip direction for strata is an important aspect as it can give
calculation errors (negative values) for the true thickness.
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Fig. 8 Outcrop belt with Top and Base of unit (point features)
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Fig. 9 Zoom in map of the outcrop belt location with distance lines between points
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Fig. 10 Outcrop belt with Strike and Dip measurements (observe that the strike remains
relative constant along the profile)
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IEECECTEEE
Outcrop Belt
——— — — =
FID Shape | ID X ¥ X1 bl Distance Difference Dip Radians_Di Angle | Angle_rad Elevation1 Elevation xyline22.Thickness

0 | Polyline 1| 5636078.024745 | 349341.685676 | 5636088.542145 | 348315.184307 | 33.515463 384 25 0.278111 0 o 1521.86 1517 4 8.15

1 | Polyline 2| 5636079.967636 | 349343.279468 | 5636100.446083 | 349216.860129 33.34778 3TT 25 0.278111 0 o 1521.37 1516.7: B8.15

2 | Polyline 3| 5636081.910526 | 349344.873263 | 5636102.350031 349318.73596 | 33.180295 344 25 0.279111 0 o 1520.52 1516.3 818

3 | Polyline 4| 5636083.853416 5636104.253968 | 349320511783 33.01301 3.21 25 0.279111 0 o 1519.61 151564 8.21

4 | Polyline S | 5636085.706306 5636106.157904 | 340322287607 | 32.845027 297 25 0.279111 0 o 1518.89 1515.24 823

5 | Polyline 6 | 5636087.739195 5636108.06184 | 340324.083433 3267905 274 25 0.279111 0 o 151821 1514, q 825

& | Polyline 7| 5638089.882084 5636100.965786 349325.83925 | 32512397 234 25 0.279111 0 o 1517.32 1514, 14 831

7 | Polyline 8| 5638091624083 5636111.860721 | 340327815077 | 32.345034 219 25 0.279111 0 o 1516.48 1513.4 8.3

& | Polyline 9 | 5636093567871 349354436036 | 5636113.773655 | 349329.390905 | 32179688 242 25 0.279111 0 o 1515.68 1512 81 82

S | Polyline 10 | 5636095510759 | 349356.029836 56361156776 | 349331168724 | 32.013882 214 25 0.279111 0 o 151529 1512 3¢ 823
10 | Polyline 11| 5636087 453647 | 349357.623628 | 5636117.581534 | 349332842545 | 31.847884 215 25 0.278111 0 o 1514.53 1511.61 818
11 | Polyline 12 | 5636099396545 34935821743 | 5636119.485478 | 349334 718376 | 31682312 184 25 0.278111 0 o 1513.82 15112 822
12 | Polyline 13 | 5636101338431 | 349360.811223 | 5636121.389411 | 349336.494198 31.51687 171 25 0.278111 0 o 1513.12 1510 6 821
13 | Polyline 14 | 5636103282329 | 349362405018 | 5636123.293354 | 349338.270022 31.35186 171 25 0.278111 0 o 1512.34 1508 99 817
14 | Polyline 15 | 5636105225215 | 349363.996813 | 5636125.197286 | 349340.045846 | 31.186888 1.01 25 0.278111 0 o 1511.68 1508 6! 8.31
15 | Polyline 16 56361071681 | 349265.592609 | 5636127.101228 | 349241 821671 31.022364 0.84 25 0.278111 0 o 1510.66 15 8.32
16 | Polyline 17 | 5636109.110997 | 349367.186406 5636129.00517 | 349343.587489 | 30.857983 019 25 0.279111 0 o 1509.84 150863 B8.45
17 | Polyline 18 | 5636111.053881 | 349368.780204 | 5636130.909111 | 349345.373316 | 30.693852 0.03 25 0.279111 0 o 1508.61 1508.04 B8.45
18 | Polyline 19 | 5636112096777 | 349370.373094 | 5636132.813041 | 349347.140144 | 30.520052 -0.51 25 0.279111 0 o 1508.09 15073 B8.55
19 | Polyline 20 | 5636114030661 | 349371.067793 | 5636134.716082 | 340348.924064 | 30.366336 -0.24 25 0.279111 0 o 1507.19 1507.04 86
20 | Polyline 21| 5636116882556 | 349373.561584 | 5638136.620022 | 340350.700793 | 30.202061 -1.25 25 0.279111 0 o 1508.22 1508.47 8.67
21 | Polyline 22 5636118.82545 | 349375.155385 | 5636138.524861 | 349352.476815 | 30.030884 -1.37 25 0.279111 0 o 150522 1508. B8.85
22 | Polyline 23 | 5636120768333 | 349376.749178 | 5636140428801 | 349354 252438 | 29.877036 177 25 0.279111 0 o 1504.73 1505 5 872
23 | Polyline 24 | 5636122711227 | 349378.342972 | 5636142332739 | 349356.028262 | 29.714476 224 25 0.279111 0 o 1503.786 1505.01 88
24 | Polyline 25 563612465412 | 349379.936767 | 5636144.236678 | 349357 804086 | 29.552193 267 25 0.278111 0 o 1502.83 1504 51 8.88
25 | Polyline 26 | 5636126597013 | 349381.530562 | 5636146.140615 | 349358.579911 29.390183 292 25 0.278111 0 o 15018 1504. 88
26 | Polyline 27 | 5636128538804 | 349383.124358 | 5636148.044553 | 349361355738 | 29.208489 -3.18 25 0.278111 0 o 1501.18 1503 .44 893
27 | Polyline 28 | 5636130482787 | 349384.718156 5636149.94849 | 348363131556 | 28.067075 -335 25 0.278111 0 o 1500.28 1502.8 893
28 | Polyline 29 | 5636132425679 | 349386.311954 | 5636151.852426 | 349364807384 | 28.905853 -3.36 25 0.278111 0 o 1489.46 1502.27 8.88
28 | Polyline 30 5636134.36857 | 349087.905752 | 5636153.T56362 | 349366.683204 | 26.745139 -3.31 25 0.278111 0 o 1488.891 1501 6. 8.83
30 | Polyline 31| 5636136311461 | 349389.499543 | 5636155.660309 | 349368.459034 | 26.584628 -3.59 25 0.279111 0 o 1488.32 1501.1 B8.86
31 | Polyline 32 | 5636138254352 | 349381.093344 | 5636157.564244 | 349370.234856 | 28.424434 =372 25 0.279111 0 o 1487.56 1500. B8.86
32 | Polyline 33 | 5636140107242 | 349302.687136 | 5636150.468179 | 349372.010679 | 28.264552 -3.79 25 0.279111 0 o 1496.78 14997 8.83
33 | Polyline 34 | 5636142140132 34030428093 | 5636161.372124 | 340373.786503 28108 -4.04 25 0.279111 0 o 1495.99 1#% B8.86
34 | Polyline 35 | 5636144083022 | 349305.874724 | 563B163.276058 | 340375.562327 2784577 -4.04 25 0.279111 0 o 1485.24 1498, 8.81
35 | Polyline 35 | 5B36148.025011 | 349307.468527 | 563B165.179001 | 340377.333153 | 27.788881 -3.96 25 0.279111 0 o 1484.48 14977 875
36 | Polyline 37 56361479688 | 349399.062323 | S5636167.083935 | 349379113971 27 62834 -3.93 25 0.279111 0 o 1483.79 1498 7 889
37 | Polyline 38 | 5638149911688 | 349400.656111 | S5636168.987867 | 349380889798 | 27.470125 -4.08 25 0.279111 0 o 1492 .85 1496 24 889
38 | Polyline 39 | 5636151854576 | 349402.249909 5636170.89181 | 349382 665626 | 27.312276 442 25 0.278111 0 o 148214 1485 54 874
38 | Polyline 40 | 5636153797475 | 349403.843707 | 563B172.795753 | 349384 441446 | 27154783 477 25 0.278111 0 o 1481.17 1484 84 88
40 | Polyline 41| 5636155740363 | 349405.437506 | 5636174.609684 | 349386217267 | 26.997656 521 25 0.278111 0 o 1480.11 1484 34 887
41 | Polyline 42 | 5636157683249 | 349407.031297 | 5636176.603625 | 349387 893098 | 26.840885 -4.96 25 0.278111 0 o 1488.13 1483 6 876
42 | Polyline 43 | 5636158.626136 | 349408.625098 | 5636178.507556 | 349360.768921 | 26.684516 -5.52 25 0.278111 0 o 1488.69 1483 2 B8.87
43 | Polyline 44 | 5636161.568033 349410218688 | 5636180.411496 | 349391544745 | 26.528515 -5.83 25 0.278111 0 o 1487.76 1482.5 881
44 | Polyline 45 | 5636163.511919 | 349411.812684 | 5636182.315437 349393.32057 | 26.372913 817 25 0.279111 0 o 1486.68 1491, B8.97
45 | Polyline 46 | 5636165454805 | 349413.406479 | 5636184.219376 | 349395.096395 2621771 -6.39 25 0.279111 0 o 1485.63 148117 B8.98
46 | Polyline 47 | S636167.307701 | 349415.000274 | 5636186.123316 | 340306.872213 | 26.062009 -£.54 25 0.279111 0 o 142478 1490.4 898
47 | Polyline 48 | 5636160.340586 340416.50407 | 5636188.027255 340308.64804 | 25.908523 -£.287 25 0.279111 0 o 1483.86 1m 9.03
48 | Polyline 40 | 5636171283481 | 340418.187867 | 5638189.931193 340400.42386 | 25.754555 571 25 0.279111 0 o 1482.89 14&] 3.94
49 | Polyline 50 | SE36173.226365 | 349410.781664 $838191.83512 | 340402.109685 | 25.601008 -7 25 0.279111 0 o 148228 1488 3 898
50 | Polyline 51 5636175.16926 | 349421.375463 | 5636193.739058 | 349403.975511 25447502 -7.24 25 0.279111 0 o 1481.39 1487 84 9.01
51 | Polyline 52 | 5638177112143 | 349422 069253 | 5636195.643006 | 349405.751333 2529525 -7.86 25 0.279111 0 o 1430 6 1487 44 9.13
52 | Polyline 53 | 5638179.055037 | 349424 563053 | 5636157.546043 | 349407 527156 | 25.143038 -B8.26 25 0.278111 0 o 1479.62 1486 74 82
53 | Polyline 54 | 5638180897931 | 349426.156846 | 5636199.450879 | 349408302988 | 24991274 855 25 0.278111 0 o 1478.53 1486.13 924
54 | Polyline 55| 5636182840813 | 349427750647 | 5636201.354815 | 345411078805 | 24840004 838 25 0.278111 0 o 1477.57 1485.53 9.15
55 | Polyline 56 | 5636184.883706 | 349420.344441 5636203.25875 | 349412854631 2468818 852 25 0.278111 0 o 147713 1484 74 9.15
56 | Polyline 57 | 5636186826599 | 349430.936236 | 5636205.162685 | 349414.630457 | 24.538861 549 25 0.278111 0 o 1476.26 1483. 21
57 | Polyline 58 | S636188.769481 | 349432.5320H 5636207.06663 | 349416.406285 | 24.389035 -5.3% 25 0.278111 0 o 1475.41 1482.9: 8.03
58 | Polyline 59 | 5636180712372 | 349434.125828 | 5636208.970564 | 349418.182104 | 24230718 -5.02 25 0.279111 0 o 1474.56 1481.8 8.89
58 | Polyline 60 | 5636192655263 | 349435.719625 | 5636210.874498 | 340419.957925 | 24.080805 -7.82 25 0.279111 0 o 1473.79 14807 878
60 | Polyline 61| 5636104508154 | 340437.313423 | 5636212.778442 | 340421733755 | 23.042617 -7.99 25 0.279111 0 o 1472.97 1480.1 88
&1 | Polyline 62 | 5636106541045 | 349438.007213 | 5636214.682374 | 340423.500577 | 23.794853 -7.81 25 0.279111 0 o 147218 1479. 871
82 | Polyline 63 | 5636198483035 | 349440.501012 | 5836216.586318 | 340425285401 | 23.847845 -7.99 25 0.279111 0 (1] 147169 1478.89 872

£ | (0 out of 1025 Selected)

Fig. 11 Attribute Table for Outcrop Belt thickness calculation
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Fig. 13 Thickness Map showing increase thickness along the outcrop belt towards the North
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